HeadMaster
What do you want to do?
Manage Check In and Check Out Procedures (see page 2)
Promote Students (see page 11)
Track Attendance (see page 14)
Post Grades and Print Report Cards (see page 23)
Manage Student Behavior Records (see page 46)
Manage Permanent Records (see page 51)
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1 Manage Check In and Check Out Procedures
What do you want to do?
Check Individuals In or Out (see page 2)
Send a Message for an Individual During Check In and Check Out (see page 3)
Send a Message for Everyone During Check In and Check Out (see page 3)
View Check In and Check Out Information (see page 3)
Check In Visitors (see page 3)
Understand Check In and Check Out Options (see page 4)
Set Up Check In and Check Out Attendance Options (see page 5)
Set Up and Assign Check In and Check Out Billing Options (see page 6)
Set Up and Disable Auto Check Out (see page 8)
Use Individual or Mass Check In and Check Out (see page 8)
Preview or Print a Check In and Check Out Report (see page 9)
Print ID Cards Using HeadMaster Reports (see page 9)

1.1 Check Individuals In or Out
You can use a bar code scanner or a keyboard to check students, parents, staff, and other people in and
out. This is a simple and efficient way to track the arrivals and departures of students and staff to and from
your school. Often, these logged times are used for attendance tracking, billing purposes, and security.
Once individuals check in or out, the information is saved and can be accessed later. When necessary,
check in and check out information can be viewed and edited as well as printed on reports.
To check individuals in or out
1. On the Home screen, click Check In/Out. If the Add Checkout Time dialog box displays, read the
Useful Information message below this procedure.
2. Using the scanner, scan your bar code; or, using the keyboard, enter your ID#.
3. If you are using a Parent ID, select a child or children to check in.
4. If you used the keyboard to enter your ID#, press Enter on the keyboard.

Useful Information
The Add Check Out Time dialog box displays if there are individuals who haven't checked out
from a prior date. Follow the instructions at the top of the dialog box. If you select Remember
Settings, the check out times you entered will be saved in the Auto Check Out section of the
program. After you make your selections, click OK.
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1.2 Send a Message for an Individual During Check In
and Check Out
You can enter a note that can only be seen by a specific individual when he or she checks in or out.
To enter a note to display for an individual during check in/out
1. On the Home screen, click Students, Staff, or Teachers.
2. Double-click an individual.
3. To leave a message for a student, click the Notes tab; for a staff person, click the Staff tab; or for a
teacher, click the Teacher tab.
4. In the Check In/Out Notes section, enter a message.
5. Click OK.

1.3 Send a Message for Everyone During Check In and
Check Out
You can enter a note to display to all individuals when they check in or out.
To enter a note to display during check in/out
1. On the Home screen, click Options.
2. Click Check In/Out.
3. Enter a message in the Check In/Out Notes section.
4. Click Close.

1.4 View Check In and Check Out Information
With the appropriate security permissions, you can view check in/out information for a given day.
To view check in/out information
1. On the Home screen, click Check In/Out Maintenance.
2. On the toolbar, select a date from the Date drop-down list.
3. All the records for the selected date display. To view an individual log, double-click a name.

1.5 Check In Visitors
There are many reasons to electronically sign in visitors, rather than using an old-fashioned sign-in sheet.
Parents attending school functions can be signed in electronically, giving you a record of their visit
that's more secure than a sign in sheet.
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Parents and other school visitors not currently in your system are entered into your Other People
records and receive badges with their name and reason for being on school grounds upon electronic
check-in.
When a parent signs in to pick up a child, the family information is automatically cross-checked for
information pertaining to which parent may pick up that child.
You can display family-specific messages when a parent checks in a child.
To check in visitors
1. On the Home screen, click Check In/Out.
2. Enter the requested information for the visitor.

1.6 Understand Check In and Check Out Options
Once you set up a dedicated workstation computer where students, parents, and staff can check in and out
of the school, you can set the options for checking individuals in and out.
To set up Check In/Out options
1. On the Home screen, click Options.
2. Click Check In/Out.
3. On the Check In/Out tab, select the options you want.
4. Click Close.
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Additional Field Descriptions
Check In/Out Grace Period
A grace period can be set up to automatically adjust double check ins or check outs. In the event of a
double check in or check out, a message displays in the notes area letting the individual know that their
times have been adjusted. For example, if an individual accidentally scans in more than once during the
predetermined grace period, the first entry is the one that remains on the Activity report. It's
recommended that the grace period be set to one minute because it's a reasonable amount of time for
an individual to have made a scanning mistake and to have tried correcting it. Marking a grace period
as zero isn't recommended as it doesn't allow for inevitable user mistakes.
Check In/Out Notes
You can enter notes to display for all of the individuals who check in and check out. For example, enter
a note that says, "Welcome to the first day of school” or enter the lunch menu for the day. Notes
entered here are viewed by all individuals when they check in or check out. Any note that's entered for
the school or for an individual continues to display until it's changed or removed. You can also enter a
note to display for an individual. In the individual's record, click the Notes tab. In the Check In/Out
Notes section, enter any notes you want to display for the individual. For example, enter the note, "Call
your Mother" for a student. When the student checks in or checks out, "Call your Mother" displays only
for that student.
Check In/Out Password
If an individual attempts to close the Check In/Out window, they're required to enter a password if one
has been set up. This is to protect the information behind the Check In/Out window of HeadMaster. The
Check In/Out window cannot be closed without the correct password. If you forget the password, you
must shut down the workstation, restart it, and reenter as a user. After three unsuccessful attempts to
enter the password, HeadMaster closes.
Clear the Check In/Out window after 15 seconds
This default option gives the individual 15 seconds to read notes and then clears the window so that the
next individual can log in. If cleared, the last person’s information remains visible until the next person
enters his or her ID # or scans a valid bar code.
Allow Visitors to Check In/Out
When visitors check in to your system for the first time, they'll be entered into your system as Other
People.

1.7 Set Up Check In and Check Out Attendance Options
By setting attendance options, students are automatically marked absent until they check in. They can also
be marked tardy or present after checking in.
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You can set separate attendance options according to grade level. For example, if your school’s policy
states that students in grades K5 through 5th are officially tardy after 8:01 a.m., enter “8:01 AM” in the Time
Student is Tardy field. If a student checks in at 8:02 a.m., they'll automatically be marked tardy and will be
presented with the Check In/Out Tardy Notes, if any have been entered.
To set up Check In/Out Attendance options
1. On the Home screen, click Options.
2. Click Check In/Out.
3. On the Attendance tab, set the tardy and absent times and enter any notes.
4. Click Close.
To set the program to print tardy slips
1. On the Home screen, click Options.
2. Click Check In/Out.
3. On the Attendance tab, select the Print a label whenever a student is tardy check box.
4. Click Close.

Useful Information
The tardy slips print to the same printer designated for Student/Visitor labels. You can set up this
printer on the Check In/Out tab.

1.8 Set Up and Assign Check In and Check Out Billing
Options
Check in/out billing is included in HeadMaster so your school or daycare center can offer childcare billing
based on attendance. Billing can be calculated for minutes, hours, days, or weeks of attendance.
The basis of check in/out billing is the “billing plan.” Billing plans define the rate, time, and frequency at which
students will be billed.
To create a check in/out billing plan
1. On the Home screen, click Options.
2. Click Check In/Out.
3. On the Check In/Out Billing tab, click Add.
4. Enter a name for the billing plan, such as “Weekday School Care Plan”.
5. Click Add. The Add/Edit Billing Plan window displays.
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6. Enter the billing plan information, and click OK.

Useful Information
You can create additional time frames for this billing plan. For example, you charge another
rate after 6:00 pm for parents who pick up their children late.

7. Click OK.
To edit or delete a check in/out billing plan
1. On the Home screen, click Options.
2. Click Check In/Out.
3. On the Check In/Out Billing tab, select a billing plan.
4. Click Edit to add, change, or delete time frames. Click Delete to remove the entire billing plan.
5. Click OK.
To assign a check in/out billing plan
1. On the Home screen, click Options.
2. Click Check In/Out.
3. On the Check In/Out Billing tab, select a billing plan.
4. Click Assign.
5. Select one or more students, and select a billing plan from the drop-down list.
6. Click Select Plan. The billing plan appears in the list next to the student(s). If you want to
disassociate a plan from a student, select the student and click Clear Plan.
7. Click OK.

Additional Field Information
Description
A description for the time frame. For example, "After School Hours."
Rate
A billing rate and increment. For example, “$5.00 Per 1 Hour(s)."
Grace Period
The amount of time you will allow before billing starts. For example, if a child checks in at 3:30 and the
parent checked the child out at 4:35, a five-minute grace period means the parent is only charged for
one hour, not the additional five minutes.
Billing Code
The billing code can be used later when creating reports to sort and analyze whatever records the code
is attached to. If a billing code is not selected, then the charges are placed in a miscellaneous revenue
center.
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1.9 Set Up and Disable Auto Check Out
With the Auto Check Out feature, you can set or disable automatic check out times for individuals.
To set auto check out times
1. On the Home screen, click Options.
2. Click Check In/Out.
3. On the Auto Check Out tab, select the Use Auto Check Out check box.
4. Enter the check out times, and click Close.

Useful Information
If Auto Check Out is enabled, the Unlock Check In/Out button acts as a fail-safe in the event that
an interruption occurs during a mass checkout. Only click the Unlock Check In/Out button if no
individual on any computer can access the Check In/Out screen, and you're sure that a mass
checkout isn't running.

To disable auto check out times
1. On the Home screen, click Options.
2. Click Check In/Out.
3. On the Auto Check Out tab, clear the Use Auto Check Out check box.
4. Click Close.

1.10 Use Individual or Mass Check In and Check Out
With the Check In/Out Maintenance feature, you can check in and check out individual students, parents, or
teachers. Or, you can check in and check out multiple individuals at the same time.
To check in or check out an individual
1. On the Home screen, click Check In/Out Maintenance.
2. On the toolbar, click the Date drop-down list, and select a date.
3. Double-click an individual's record. The Check In/Out dialog box displays.
4. In the dialog box, click New to add a new time range. Click Edit to edit a selected time range. Click
Delete to delete a selected time range.
5. Click OK.
To check in or check out multiple individuals at the same time
1. On the Home screen, click Check In/Out Maintenance.
2. On the toolbar, click the Date drop-down list, and select a date.
3. On the toolbar, click Mass Check In/Out.
4. Select either Mass Check In or Mass Check Out.
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5. Click the View Type drop-down list to select a type. Clear check boxes for individuals you don't want
to check in or check out.
6. Enter the check in or check out time in the Check In Time or Check Out Time field.
7. Click OK.

1.11 Preview or Print a Check In and Check Out Report
You can print a Check In/Check Out Report for any date, student, or staff member.
To preview or print a Check In/Check Out report
1. On the Home screen, click Check In/Out Maintenance.
2. On the toolbar, select a date from the Date drop-down list.
3. On the toolbar, click the View Type drop-down list, and select the type you want to view.
4. On the toolbar, click Preview or Print.

Useful Information
You can access all of the Check In/Out reports by clicking the Reports button on the Home screen.

1.12 Print ID Cards Using HeadMaster Reports
You can print student ID cards using the Zenius and Primacy ID Card printers. Instead of using the eMedia
software, you can print directly from the Student ID Cards {Avery 5371} report. You'll need to contact
HeadMaster Support at 1-800-669-2509 to get a file to use with this report.

1.12.1 Support Use Only
Click here to download the file you will need to give to the client.
To print student ID cards from HeadMaster Reports
1. On the Home screen, click Reports.
2. In the Report List, expand List.
3. Select Student ID Cards (Avery 5371).
4. Right-click on the report, and click Copy. The Copy report dialog box displays.
5. Enter a report name, and click OK. The copy of the report is added to the bottom of the List section of
the Report List.
6. Right-click on the copy of the report, and click Edit. The ReportBuilder displays.
7. Click File, Open. Open the file given to you by HeadMaster Support.
8. On the toolbar, click Label

, and click anywhere on the badge to insert the label.

9. Delete the label. (This is to make a change in the report so that it can be saved.)
10. Click Close

. When the confirmation message displays to save changes, click Yes.
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11. Optional: To use a previously saved search, click the Use Search list. Searches will be limited to the
appropriate type.
12. Optional: To sort data on the report, click the Sort by list. Sort by arranges data in ascending or
descending order for the field selected. Next, select either the Ascending or Descending option.
13. Optional: To group data on the report, click the Group by list.
14. Optional: Set filters as desired.
15. To preview the report, click Print Preview. To print, click Print.
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2 Promote Students
What do you want to do?
Prepare for Promotion (see page 11)
Promote Students to the New Year (see page 11)
Access the New Dataset After Promotion (see page 13)

2.1 Prepare for Promotion
Promotion is the action of moving a group of students to the next grade level. This is achieved by creating a
new database and adding the promoted students to their new grade level. You can select one or several
databases to promote at one time.
Once you complete the school year, an administrator can promote students to the next grade level.
However, there are several tasks you must complete prior to promoting students.
Before promoting students, complete the following year-end procedures:
Calculate grades and attendance.
Print final report cards.
Update permanent records.
Mark failed students, “Do Not Promote.”
Create a backup.
Ensure grade levels are in the correct order in HeadMaster. For more information, see Manage Grade
Levels.
If a student isn't being promoted, you can indicate that the student should be held back in the same grade for
the next school year.
To mark students as “Do Not Promote”
1. On the Home screen, click Students.
2. Select the first student not being promoted. To open the student record, double-click the student.
3. Click the Student tab.
4. Select the Do Not Promote check box.
5. To save, click OK.
6. Repeat for each student you don't want to promote.

2.2 Promote Students to the New Year
After you have prepared for promotion (see page 11), and before you begin the promotion routine, review
the grade levels and make sure they're in the correct order. For more information, see Manage Grade Levels
.
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Note
All other users must exit HeadMaster prior to you running the promotion utility.

Tip
To start the Utility Manager, on the Windows® Start menu, click All Programs. Point to
HeadMaster, and click Utility Manager. You will be prompted to enter your user name and
password.

Note
Once you promote a database, it cannot be "unpromoted". Back up your data before you begin the
promotion routine.

To create a backup
1. On the Windows taskbar, click Start.
2. Point to All Programs > HeadMaster > Utility Manager.
3. Log into HeadMaster.
4. Click Create Backup.
5. Click Browse to select the location where save the backup.
6. Select any other options you want.
7. Click Backup.
When you're promoting students to a new year, only unpaid invoices and outstanding payment credits are
transferred. Any students, active or inactive, with an outstanding debit or credit balance transfer to the new
dataset. Multiple invoices for the same billing code combine into one transaction for the total billed amount,
and the invoice date is the date of the most recent invoice from the original dataset.
For partially paid invoices, only the remaining balance transfers to the new dataset. All credit balances are
attached to family records with the original payment date.
If any promoted Alumni have an outstanding balance, they remain on the student grid and are labeled as
Inactive with a blank grade level. These Alumni print on all Billing reports that include Inactive students.
To perform promotion
1. In Utility Manager, click Promote.
2. Select a dataset, and click Next.
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3. Enter the new database name. For example, if the old dataset was named 08-13 the new name would
be 09-14. The New Database Name is limited to 8 characters.

Useful Information
You will use multiple datasets only if you are promoting students from elementary to middle
or high school and the students are stored in different datasets.

4. Click Next.
5. Verify the order of the new grade level.
6. For the last grade level, select either Do Not Promote or Alumni.
7. Click Next.
8. Make your selections, and click Finish.

2.3 Access the New Dataset After Promotion
Before you can open the new dataset, you must close the Utility Manager.
To access the new dataset, in the HeadMaster login window, enter your user name and password, click the
Dataset drop-down list, and select the name of the new dataset. Click OK.
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3 Track Attendance
What do you want to do?
Define Custom Reason Codes for Absences and Tardies (see page 14)
Post Attendance (see page 15)
Post Attendance for Selected Students (see page 16)
Mark Attendance with the Seating Chart (see page 17)
Post School Attendance (see page 17)
Perform an Attendance Inquiry (see page 20)
Set the Number of Unexcused Tardies that Equal an Absence (see page 21)
Delete Attendance Postings for School or Class Attendance (see page 21)

3.1 Define Custom Reason Codes for Absences and
Tardies
You can create a custom list that contains typical reasons for student and staff tardiness or absence. For
example, individuals may be tardy due to doctor or dentist appointments, traffic-related problems, or
because they overslept. They may be absent due to a death in the family, illness, or vacation.
While reason codes are optional, if you plan to use them, you should set them up prior to taking attendance.
Once set up, you can quickly select the reason for the student or staff person’s absence from a Absence
Reason list in the attendance window.
To add reason codes
1. On the Home screen, click Define List.
2. In the Available Fields list, expand Attendance and click Reason Codes.
3. Click Add.
4. Enter the reason, and click OK.
To edit or delete reason codes

Note
When you edit or delete reason codes, the code is changed throughout all records using the code.

1. On the Home screen, click Define List.
2. In the Available Fields list, expand Attendance and click Reason Codes.
3. To change a code, double-click it.
4. Make the changes, and click OK.
5. Click Yes.

Page 14 of 66

HeadMaster

3.2 Post Attendance
If you have HeadMaster Plus, HeadMaster Pro, and HeadMaster Pro with Classroom Manager, you can post
attendance using the Class Attendance Assistant. With Classroom Manager, you can also post attendance
on the seating chart.
You can post attendance for multiple classes at one time using the Class Attendance Assistant. You can
also post attendance by students using the same assistant.

Note
You don't need to mark students present, as this is selected by default. However, you can select a
reason code if a student is in school but attending a school function during class time. Only mark
students who are absent, tardy, unexcused absent, unexcused tardy, or none. If everyone in the
school is present, you must still open the assistant and click OK to post the attendance for that day.

To post attendance for multiple classes
1. On the Home screen, click Class Attendance.
2. Select a date to post attendance for, and click OK.
3. Select By Class in the View drop-down list.
4. In the Classes list, double-click any classes you don't want to post attendance for. This clears the
check box for the class.
5. In the Code section, select the attendance code you want to mark first. For example, to mark all
absent students, select Absent.
6. In the Students section, double-click the student whose marking you want to change.
7. Optional: Select the reason that the student is absent from the Reason Code list.
8. Repeat steps 5 through 8 for each class that has Absent, Tardy, Unexcused Absent, Unexcused
Tardy, or None markings.
You can post attendance for selected students using the Class Attendance Assistant.
To post attendance for selected students
1. On the Home screen, click Class Attendance.
2. Select a date to post attendance for, and click OK.
3. Select By Student in the View drop-down list.
4. In the Students list, double-click any students you don't want to post attendance for. This clears the
check box for the student.
5. In the Code section, select the attendance code you want to mark first. For example, to mark all
absent students, select Absent.
6. Click to select the first student.
7. In the Classes section, double-click the class you want to change the marking for.
8. Optional: Select the reason that the student is absent from the Reason Code list.
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9. Optional: To give the same mark for all of the student’s classes, click Fill Down after marking the
first class. For example, if a student is absent from all classes, you can mark the first class with
Absent then click Fill Down to automatically mark all other classes as Absent.
10. Repeat steps 5 through 9 for each student that has Absent, Tardy, Unexcused Absent, Unexcused
Tardy, or None markings.
11. To post attendance for all of the selected students, click OK.

Note
You can use the Filter option to set a range of students or classes for each user. This way, a user
can easily mark the students or classes they are in charge of without needing to sort through
everyone. Remember that once a filter is set, it remains in effect until the filter is changed manually.

3.3 Post Attendance for Selected Students
You can post attendance for selected students using the Class Attendance Assistant.
To post attendance for selected students
1. On the Home screen, click Class Attendance.
2. Select a date to post attendance for, and click OK.
3. Select By Student in the View drop-down list.
4. In the Students list, double-click any students you don't want to post attendance for. This clears the
check box for the student.
5. In the Code section, select the attendance code you want to mark first. For example, to mark all
absent students, select Absent.
6. Click to select the first student.
7. In the Classes section, double-click the class you want to change the marking for.
8. Optional: Select the reason that the student is absent from the Reason Code list.
9. Optional: To give the same mark for all of the student’s classes, click Fill Down after marking the
first class. For example, if a student is absent from all classes, you can mark the first class with
Absent then click Fill Down to automatically mark all other classes as Absent.
10. Repeat steps 5 through 9 for each student that has Absent, Tardy, Unexcused Absent, Unexcused
Tardy, or None markings.
11. To post attendance for all of the selected students, click OK.

Note
You can use the Filter option to set a range of students or classes for each user. This way, a user
can easily mark the students or classes they are in charge of without needing to sort through
everyone. Remember that once a filter is set, it remains in effect until the filter is changed manually.
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3.4 Mark Attendance with the Seating Chart
You can use the seating chart to mark class attendance. This is extremely useful for substitute teachers who
don't know student names.
To use the seating chart to mark class attendance, you must first turn this option on in Options.
To use the seating chart to mark attendance
1. On the Home screen, click

.

1. Click the Mark Attendance button.
2. Click on each student's desk to change the attendance marking.
3. When you finish marking attendance, in the bottom, right corner of the window, click the Save
Attendance button.

Note

To leave attendance mode, on the toolbar, click

.

Useful Information
While viewing the seating chart, you can select a new date and/or class to mark attendance for. On
the Mark For drop-down list, click the Lookup button, and make your selections.

3.5 Post School Attendance
School attendance is taken once a day and can be used to count the number of hot lunches needed.

Useful Information
If you use the Check In/Check Out feature available in HeadMaster Pro, you should not use the
School Attendance Assistant to record school attendance. Instead, refer to Manage Check In and
Check Out Procedures (see page 2).

Students don't have to be assigned to a homeroom teacher in order to record school attendance, but they
won't display if you use a homeroom teacher filter. Additionally, if you use HeadMaster Pro, you also need to
set dates for grading periods. For more information, see Set Dates for Grading Periods (see page 39).
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Useful Information
The Student Profiles report lists each student’s homeroom teacher.

Prior to posting school attendance, complete the following tasks:
Set up Reason Codes. Reason Codes are brief explanations for why a student is tardy or absent,
such as Sick, Funeral, Doctor, Dentist, or Traffic. For more information, see Define Custom Reason
Codes for Absences and Tardies (see page 14).
Set up Grade Levels. See Manage Grade Levels.
Add students and assign homeroom teachers. See Add a New Student or Change a Student’s
Homeroom Teacher.
If you use HeadMaster Pro, set up grading periods. See Set Dates for Grading Periods (see page 39
).

3.5.1 Post Staff Attendance
When you post staff attendance, you can mark attendance for both teachers and staff members.
To post staff attendance
1. On the Home screen, click School Attendance.
2. Enter a date in the Mark Date field, or click Select Date.
3. In the View drop-down list, select Staff.
4. By default, every staff person is set to Present. To mark any other attendance type, select an
attendance Code.
5. Double-click each staff person’s name to change the attendance mark to the code you selected.

Useful Information
If the staff person doesn't want to order lunch, clear the Hot Lunch check box. Note: When a
staff person is marked absent, the Hot Lunch check box is cleared automatically.

6. Optional: You can select or add a Reason Code for the staff person’s tardiness or absence from the
Reason list next to the individual’s name. Examples include: Doctor, Sick, Funeral, or Traffic.
7. Repeat steps 4, 5, and 6 for each attendance code you want to use.
8. To save attendance markings, click OK.

Tip
You can also right-click a staff person’s name and select an attendance code.
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3.5.2 Clear School Attendance Totals
If you manually enter attendance, you may need to clear school attendance totals at the end of each
semester or at year’s end.
To do this, you can use the Clear School Attendance Totals Assistant. This clears the attendance totals
found on the Student tab for each student record.
School attendance totals are found on each student record
To clear school attendance totals
1. On the Tools menu, click Assistants > Clear School Attendance Totals.
2. Click Yes.

3.5.3 Post Student Attendance for the School
You can post attendance for one grade level or the entire school using the School Attendance Assistant.
To post attendance for the entire school using the School Attendance Assistant, select ALL in the Grade
Level list. Students in all grade levels display and are made available for attendance markings.

Useful Information
If you use the Check In/Check Out feature in HeadMaster, you shouldn't use the School
Attendance Assistant. For more information about Check In/Out, see Manage Check In and Check
Out Procedures (see page 2).

To post student attendance
1. On the Home screen, click School Attendance.
2. Enter a date in the Mark Date field, or click Select Date.
3. Optional: To filter by a specific grade level, select a Grade Level in the Grade Level drop-down list.
4. Optional: To filter by teacher, select a name from the Homeroom Teacher drop-down list.

Useful Information
If you use Classroom Manager and you log in as a teacher, you will only see your student
list.

5. By default, every student is set to Present. To mark any other attendance type, select an attendance
code.
6. Double-click each student’s name to change the attendance mark to the code you selected.
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7. If the student doesn't want to order lunch, clear the Hot Lunch check box. Note: When a student is
marked absent, the Hot Lunch check box is cleared automatically.
8. Optional: You can select or add a reason code for the student’s tardiness or absence from the
Reason Code list next to the student's name. Examples include: Doctor, Sick, Funeral, or Dentist.
9. Repeat steps 5, 6, and 7 for each attendance code you want to use.
10. To save attendance markings, click OK.

Tip
You can also right-click a student’s name and select an attendance code.

3.5.4 Recalculate School Attendance Totals
To recalculate the school attendance totals, use the Calculate Grades & Attendance Assistant. For more
information, see Calculate Grades (see page 23).

Useful Information
If the attendance totals were entered manually, you cannot recalculate them using the Calculate
Grades & Attendance Assistant.

3.6 Perform an Attendance Inquiry
An Attendance Inquiry displays a calendar view of the selected individual’s attendance for a specific month.
Attendance totals for the month, as well as overall attendance totals, display to the right of the calendar.
Additionally, if you applied attendance reason codes while taking attendance, the reason code displays when
you click on the date the individual was absent.
You can perform an attendance inquiry to check school attendance for any of your staff, including teachers.
To perform an Attendance Inquiry
1. On the Home screen, click Staff or Teachers.
2. Double-click an individual’s record.
3. Click the Staff or Teacher tab.
4. Click Inquiry.
You can perform an attendance inquiry to check school attendance for a student.
To perform an Attendance Inquiry
1. On the Home screen, click Students.
2. Double-click a student's record.
3. Click the Student tab.
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4. In the School Attendance section, click Inquiry.

3.7 Set the Number of Unexcused Tardies that Equal an
Absence
In Attendance Options, you can set the number of unexcused tardies that equal one absence. You can use
this setting when calculating attendance for:
Report Cards
Student tab
Post Grades
HeadMaster Online
Class Roster Attendance Summary report
School Attendance Summary report
Student Attendance Summary report
To enter the number of unexcused tardies that equal one absence
1. On the Home screen, click Options.
2. Click Attendance.
3. Enter an amount. For example, 2 unexcused tardies equal 1 unexcused absence.

3.8 Delete Attendance Postings for School or Class
Attendance
If you want to remove all school or class attendance postings from your Headmaster data, use the Delete
Attendance Utility. Generally, this utility is used to free up hard drive space or for housekeeping purposes,
such as to remove markings for a specific term.
Prior to using the Delete Attendance Utility, we recommend that you complete the following tasks:
Print a copy of the attendance records for the time frame you plan to delete.
Back up your HeadMaster data.
Require all users to exit HeadMaster. (Required)
To delete attendance records
1. On your Windows desktop, click Start > All Programs > HeadMaster > Utility Manager.
2. Enter your password, and click OK.
3. Click Delete Attendance.
4. At this point, you must call customer support at 1-800-669-2509 and obtain Today’s Password.
5. Enter the password, and click OK.
6. In the Select Database list, select a dataset to remove attendance postings from.
7. In the Attendance Type section, select Delete School Attendance or Delete Class Attendance.
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8. If you choose to delete class attendance, you have the option to select a specific class to delete. In
the drop-down list below the Delete Class Attendance option, select the class with the attendance you
want to delete.
9. Enter a date range in Start Date and End Date, or click to select dates from a calendar.
10. Click Delete Markings.
11. Click Yes.
12. Click OK. You can now log back in to HeadMaster.
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4 Post Grades and Print Report Cards
What do you want to do?
Calculate Grades (see page 23)
Customize the Gradebook (see page 24)
Enter Skill Grades (see page 31)
Get Ready to Print Report Cards (see page 33)
Set up Grading Options (see page 36)
Access the Post Grades Assistant (see page 45)

4.1 Calculate Grades
Useful Information
To enter, calculate, and post grades, you must have HeadMaster Pro™ or HeadMaster ProCM™.

Lower school administrators and teachers often need to post skill grades. HeadMaster’s Skills Assistant
walks administrators through setting up a skills grading scale and building a skills list. Once these options
are set up, the administrator can then assign skills to classes and subjects. Finally, teachers can use the
Skills Assistant or the Post Grades Assistant to post skill grades.
When report card time arrives, administrators can use the Calculate Grades and Attendance Assistant

to

quickly calculate and post period averages. Grades can be calculated for the entire school or by grade level.
With this assistant you can calculate grades for the entire school or by grade level. After you calculate
grades, you can view the results in the Post Grades Assistant.

Note
The Calculate Grades assistant must be run prior to:
Printing report cards
Running Update Permanent Records Assistant
Viewing Current Average/GPA on the student record

To calculate grades
1. On the Home screen, click Calculate Grades. The Calculate Grades dialog box displays.
2. Make your selections, and click Calculate.
3. When calculations are complete, click OK.
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4.2 Customize the Gradebook
With HeadMaster ProCM, you can enter assignments and grades in the gradebook, as well as teacher
comments that will print on the report card.
On the Home screen, click Post Grades. The Post Grades Assistant displays.
By default, the Post Grades Assistant displays all grading periods. However, if you only want to view specific
grading periods or a semester, on the toolbar, click the Grading Period drop-down list and select a period to
view.
To set additional display options for class grades, on the toolbar, click Customize. The Customize Post
Grades dialog box displays. Make your selections to display in the gradebook.
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Additional Field Descriptions
Show Period Absences
All student absences for the grading period.
Show Period Tardies
The number of times the student reported late to class for the grading period.
Show Total Absences
All student absences for the term.
Show Total Tardies
The number of times the student reported late to class for the term.
Show Period Effort
The markings for student effort for the period.
Show Effort
The markings for student effort.
Show Credits
The credits earned for the class by each student.
Show Grade Points
The grade points earned for the class by each student.
Show Letter Grade 1
Displays a student’s current letter grade 1. This letter grade is determined when the grading scale is set
up.
Show Letter Grade 2
Displays a student’s current letter grade 2. This letter grade is determined when the grading scale is set
up.
Show Assignments
Assignments in the gradebook. (Classroom Manager only)

Useful Information
If you select to sort grades according to Assignment Type, the grades are grouped and sorted by
the Assignment Type currently assigned. The type sorting is in alphabetical: A to Z or alphabetical:
Z to A order and within each type the grades are sorted according to date. Whether the sorting is in
ascending or descending order depends on your selection in Order By.
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4.2.1 Select and Open a Gradebook with the Post Grades
Assistant
To access the Post Grades Assistant, on the Home screen, click Post Grades. All gradebooks display in the
left pane. In order to quickly locate a class, you can filter this list by teacher or by grade level with the
drop-down lists. In the collapsible list view, select the class name. The gradebook for the class displays.

Set up Footnotes (Teachers Only)
Teachers can add unlimited footnotes to help explain the reasoning behind certain grades.
To set up footnotes
1. On the Home screen, click Post Grades.
2. Select a class for which you want to enter footnotes.
3. On the toolbar, select Footnote.
4. Click Manage.
5. Click Add.
6. Enter the text for your footnote, and click OK.
7. Click OK.

Apply Footnotes to Student Grades
Footnotes are available for teachers to add details specific to a grade given. For example, a failing grade can
have the explanation attached with a Footnote, such as “Turned in late.”
To apply a footnote to a student’s grade
1. Select the cell that contains the grade you want to add a footnote to.
2. Right-click, and click Footnote.
3. Select the footnote you want applied.
4. The footnote appears in the cell that contains the grade you selected.

Enter Assignments in the Gradebook
One of the most convenient ways to add assignments is to add them while you're working in the gradebook.
However, you cannot edit or delete assignments from here.
To open the gradebook, on the Home screen, click Post Grades.
To add assignments from the gradebook
1. In the gradebook, select the class you want to add assignments to.
2. On the toolbar, click Assignments > New Assignment. The New Assignment dialog box displays.
3. Enter a Name. Give your assignment a unique name to identify it. For example, enter “Principles of
Algebra pp. 101-102.”
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4. Enter a brief Description of the assignment. For example, enter “All even numbered problems, show
work.”
5. To select the date the work is assigned and the date that the work is due, click

beside Date

Assigned and Date Due.
6. To select the time frame (semester or grading period) within the school year or term in which the
assignment’s grade will be calculated, click the Grading Period list.
7. Under Weight, click the Assignment Type drop-down list to select a default assignment, or, to create
a new one, select <New>. Once the assignment type is selected, the How many times does this
assignment count? field defaults to the weight set up in the assignment type. If you use the point
scale, How many points is this assignment worth? displays. You can edit the number.
8. Optional: To add additional comments, click the Notes tab.
9. Click OK. The assignment is added to the top of the gradebook in the grading period you indicated.

Mark an Assignment as Incomplete
When using the grade book, teachers can mark an assignment or a grading period as incomplete. When
marked incomplete, the assignment or the grading period won't count toward the student’s GPA or average.

To mark an assignment as incomplete
1. In the gradebook, select the student’s cell for the incomplete assignment.
2. On the toobar, click Incomplete.
3. Click OK.

Note
If you want to remove an incomplete mark from a student's grade, select the incomplete grade and
click Incomplete. The grade then becomes null. You can also select the incomplete grade and
enter a new grade to overwrite the incomplete mark.
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Enter Grades in the Gradebook
To open the gradebook, on the Home screen, click Post Grades. You can enter a grade within each cell,
and press the Enter key on your keyboard to save it. Use the arrow key on your keyboard to move to a new
cell.

Enter Skill Grades in the Gradebook
You can post skill grades while viewing the gradebook.
Before posting skill grades, you must have entered skills for the subject. For more information, see View,
Add, and Delete Skills for Classes.
You can also access skill grades using the Skills Assistant. To review and edit skill grades using the Skills
Assistant, on the Home screen, click Skills.
To post skill grades
1. On the toolbar, click Skills. The Skills window displays.
2. Select Mark Skill Grades, and click Next.
3. Select a class from the Class drop-down list.
4. Click the Grading Period drop-down list, and select the grading period for which you want to post skill
grades.
5. In the Students list, select a student. The skills for each class display on the right-hand side.
6. Click the drop-down arrow next to each skill and select a skill grade (usually Excellent, Satisfactory,
Needs Improvement, Unsatisfactory, or Not Applicable).
7. After you select a grade for each skill, repeat steps 5 and 6 for each student.
8. When finished marking skill grades, click Save.

Enter the Same Grade for All Students
When most or all of your students earned the same grade for an assignment or quiz, you can save time by
entering the same grade for all students at once. Then, you can change the grade for the few students who
earned a different grade.
To enter the same grade for all students
1. On the Home screen, click Post Grades.
2. On the left sidebar, select a teacher and grade level from the drop-down lists.
3. In the assignment grid, select the assignment you want to add a grade for.
4. On the toolbar, click Update All > Enter a grade for all students.
5. Enter the grade, and click OK.

Exclude Grades From the GPA Calculation
You can exclude a grade from the overall calculation of the GPA for one or more students.
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Example 1 – Mr. Smith told his class that he'd exclude each student’s lowest quiz score for each nine-week
period prior to calculating final grades. In this case, Mr. Smith will use step 2 in the procedure below to omit
the lowest quiz grade for each student.
Example 2 – During the final week of the report card period, Mrs. Kennedy gave her students a test.
However, no student scored higher than a 70 on the test. Because Mrs. Kennedy is concerned that her
students didn't understand the unit, she'd like to exclude this set of test scores for all of her students. Mrs.
Kennedy plans to re-teach the concepts and test again in the next nine week period. Mrs. Kennedy will use
step 3 in the procedure below to omit the lowest test grade for all students in the class.
To exclude a grade from the calculation of the GPA
1. On the Home screen, click Post Grades.
2. On the left sidebar, select a teacher and grade level from the drop-down lists.
3. In the assignment grid, select the cell that contains the grade you want to exclude.
4. To exclude the grade for a single student, on the toolbar click Omit.
5. To exclude the grade for all students, on the toolbar, click Update All > Omit for all students.

Useful Information
If you need to reverse the action in Step 5, click the Update All list and select Include for
all students. The grade will now be considered when calculating the GPA.

Enter Notes to Print on Report Cards
Notes entered in the gradebook will print on a student's report card.
To enter teacher notes to print on report cards
1. On the Home screen, click Post Grades.
2. On the left sidebar, select a teacher and grade level from the drop-down lists.
3. In the class list, select a class.
4. Select a student from the list, and click inside the grading period you want to enter notes for.
5. Click in the Teacher Comments area, and enter the notes you want printed on the report card.
6. Click OK.
You can also manage notes that are used often, such as "Great job!," and add them to the report cards.
To manage common report card notes
1. On the Home screen, click Post Grades.
2. On the left sidebar, select a teacher and grade level from the drop-down lists.
3. In the class list, select a class.
4. Select a student from the list, and click inside the grading period you want to enter notes for.
5. At the bottom of the window, click Manage. The Select/Manage Comments dialog box displays.
6. Click Add. The New Comment dialog box displays.
7. Type your comment, and click OK.
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8. In the Select/Manage Comments dialog box, select the comment you want to add.
9. Click OK.

If you want to add the comment for the selected assignment to all students in the class, click
Apply to All. Otherwise, repeat steps 1 - 9 for each student.

Tip
To view all report card notes, click the View All button.

Set Grade Status
Grade Status is used to track a student’s status or overall standing in the class. It's not a required field. It's
often used when a school prefers to print a grade status (such as Active, Withdrew, Failed, Dropped, or
Incomplete) on the report card either with or without the grade.
For example, you can select “Incomplete” to note on the report card that the student’s work is unfinished.
The grade status prints on the report card beside the grade. You can select to omit the grade and print only
the grade status. For help with this, see Print Report Cards (see page 34).
Before entering grade status, the school administrator should define or customize the possible grade status
selections for your school.
To define grade status choices
1. On the Home screen, click Define List.
2. In the Available Fields list, expand Student and click Grade Status.
3. A list of available grade status types appears in the right hand window along with options to add, edit,
delete, or print.
4. After you're done with an option, click OK.
To set the grade status for a student
1. On the Home screen, click Post Grades. The Post Grades Assistant displays.
2. On the left sidebar, select a teacher and grade level.
3. Select a class.
4. Select a student's name.
5. In the lower right-hand corner of the window, click the Grade Status drop-down list.
6. Select a status.
7. Click OK.
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4.3 Enter Skill Grades
Many schools track skills along with grades, especially lower schools. For example, a first grade student may
have a math grade, as well as grades for different math skills such as adding and subtracting.
With HeadMaster, you can track skills along with your subjects as well as print skills and skill grades on
report cards.
Before entering skill grades for students, complete these tasks:
An administrator must create the skills grading scale.
Add skills that students must master. This may be completed by the teacher or an administrator.

4.3.1 Create the Skills Grading Scale and Add Skills
Skills are abilities or competencies acquired through training. For example, kindergarten children may be
expected to:
Tie shoes
Add and subtract small numbers
Name body parts
Neatly write the letters of the alphabet
A sample skills grading scale is shown in the image below.

You must create a skills grading scale before you can add skill grades or print them on report cards.
To create the skills grading scale
1. On the Home screen, click Skills.
2. Select Add/Delete Skill Grade Codes, and click Next. The Skills window displays.
3. To add a grade for a skill, click Add.
4. You can add, edit, or delete skill grades.
5. When you are finished setting up the grading scale, click Close.
You can add, edit, delete, or print skills.
To add a skill
1. On the Home screen, click Skills.
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2. Select Add/Delete Skills, and click Next. The Skills window displays.

Useful Information
To edit skills, delete skills, or print skills, follow steps 1 - 2 and make your selection.

3. Click Add. Enter a description for the skill, and click OK.
4. Repeat Step 3 for each skill you want to add.
5. When you're finished, click Save.

4.3.2 Assign Skills to Classes and Subjects
After you set up a list of skills to be mastered by students, assign one or more skills to specific classes and
subjects.

Useful Information
Administrators typically use the Skills Assistant to add and remove skills from classes. However,
skills can also be managed in the Classes window on the skills tab.

To assign skills to classes and subjects
1. On the Home screen, click Skills.
2. Select Assign Skills to Class Subjects, and click Next. The Skills window displays.
3. From the Available Class Subjects column, select the class you want to add skills to. (Double-click the
class to view the subject associated with it.) To add multiple classes, press and hold the Ctrl key on
your keyboard as you select each class. Click Add. The classes and subjects move to the Selected
Class Subjects column
4. Click Next.
5. Under Available Skills, select a skill to add. To select multiple skills, press and hold the Ctrl key on
your keyboard as you select each skill. Click Add.
6. When you finish assigning skills, click Save.
7. Click Yes.
To remove skills from classes and subjects
1. On the Home screen, click Skills.
2. Select Assign Skills to Class Subjects, and click Next. The Skills window displays.
3. From the Available Class Subjects column, select the class you want to remove skills from.
(Double-click the class to view the subject associated with it.) To add multiple classes, press and hold
the Ctrl key on your keyboard as you select each class. Click Add. The classes and subjects move to
the Selected Class Subjects column
4. Click Next.
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5. Under Available Skills, select a skill to remove. To select multiple skills, press and hold the Ctrl key on
your keyboard as you select each skill. Click Remove.
6. To remove all skills, click Remove All.
7. When you finish removing skills, click Save.
8. Click Yes.

4.3.3 Mark Skill Grades
Administrators and teachers can mark skill grades for students using the Skills Assistant.

Note
Teachers can also post skill grades using the Post Grades Assistant, also known as the
gradebook. For more information, see Enter Skill Grades in the Gradebook (see page 28).

To mark skill grades (Administrators Only)
1. On the Home screen, click Skills.
2. Select Mark Skill Grades, and click Next.
3. Select a class in the Class drop-down list.
4. Select a grading period in the Grading Period drop-down list.
5. In the Students list, select a student.
6. Under each subject, next to the skill, select a skill grade from the drop-down lists. If each listed skill
has the same skill grade, select the first skill grade and click Fill Down

to apply the same grade to

each skill. Repeat this step for each student.
7. Repeat Steps 5 and 6 for each student in the class.
8. To post the skill grades, click Save.
To mark skill grades (Teachers Only)
1. On the Home screen, click Skills.
2. Select a class in the Class drop-down list.
3. Select a grading period in the Grading Period drop-down list.
4. In the Students list, select a student.
5. Under each subject, next to the skill, select a skill grade from the drop-down lists. If each listed skill
has the same skill grade, select the first skill grade and click Fill Down

to apply the same grade to

each skill. Repeat this step for each student.
6. Repeat Steps 5 and 6 for each student in the class.
7. To post the skill grades, click Save.

4.4 Get Ready to Print Report Cards
HeadMaster offers two predefined report card types. In this section, we'll assist you in creating and printing
report cards.
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Before you print report cards:
Enter Attendance. For more information, see Track Attendance (see page 14).
Enter grades. For more information, see Enter Grades in the Gradebook (see page 28).
Exclude any grades you do not included in the GPA calculation. For more information, see Exclude
Grades From the GPA Calculation (see page 28).
Exclude classes that should not be included on the report card. For more information, see
Troubleshoot Report Card Issues (see page 35).
Enter skill grades, if applicable. For more information, see Enter Skill Grades (see page 31).
In Post Grades Assistant, enter notes to print on the report card. For more information, see Enter
Notes to Print on Report Cards (see page 29).
In Post Grades Assistant, enter Grade Status, if applicable. For more information, see Set Grade
Status (see page 30).
Calculate Grades and Attendance. For more information, see Calculate Grades (see page 23).
Optional: Add comments to the report cards. For more information, see Enter Notes to Print on
Report Cards (see page 29).
Optional: Set up the order in which you want subjects to print. For more information, see Set the
Order of Subjects to Print (see page 35).
Optional: Set up school logo. For more information, see Add Your School Logo to Reports and
Report Cards.

4.4.1 Print Report Cards
You can set up report cards to print:
Up to eleven columns of grade period information, including numeric or letter grades, student
absences, and tardies.
Teacher notes, school absences, school tardies, and overall GPAs.
For all students, or you can select students using saved searches or filters.
Administrative comments and your school logo. For more information, see Add Your School Logo to
Reports and Report Cards.
To print report cards
1. On the Home screen, click Reports, and double-click Grades to expand grade reports.
2. Select Student Report Cards or Student Report Cards - Portrait. Select the options you want to
use.
3. Enter comments. Comments entered here will print on each report card. You can use this feature to
print a school-wide message, such as the next scheduled PTO meeting or a holiday greeting on each
student’s report card.
4. Click the Columns tab.
5. Click the Select Grading Period drop-down list, and select a grading period. Each period displays in
the Selected Columns list.
6. In the Selected Columns list, double-click to expand each period. Click the column name you want to
add to the report card (Grade, Absences, Tardies, or Effort), and click Add to move the column to the
right-hand pane. Repeat this step for each column name you want to add, up to 11 columns.
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7. Make your selections in the Additional section.
8. To generate report cards, on the toolbar, click Print.

4.4.2 Set the Order of Subjects to Print
When printing progress reports, report cards, or skills reports, you can select the order that the subjects print
on the report.
To set the order that subjects print
1. On the Home screen, click Reports.
2. Click the Grades drop-down list and select the Progress Report, Student Report Cards, or Skills
Report you want to print.
3. Click Order by.
4. To rearrange the order of subjects, click the subject name, and click Move Up or Move Down.
5. When finished, click Save.

4.4.3 Troubleshoot Report Card Issues
The following issues often occur during the printing of report cards:

The report card displays Subject Names but you prefer Class Names or vice versa. – On the Main tab of the
report cards setup window, under Options, click the Description drop-down list and select Class Names or
Subject Names.

The report card displays a “0” for the grade, but this is not correct . – Recalculate the grades (see page 23)
and attendance (see page 17).
The report card prints grades for incomplete course work. It should print the grade status “Incomplete”. – If
you prefer to print a grade status, but not the grade on the report card, you must omit the grade in the
gradebook (see page 28) and customize the columns of the report card to include the grade status. This is
especially useful in the case of incomplete grades. In the gradebook, select the grade in the calculated
average column for the grading period. On the toolbar, click Omit.
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The report card prints numerical grades instead of letter grades. – On the Home screen, click Classes.
Double-click the class you want to edit. Click the Subjects tab, and click Edit. Change the Grade Type to
Letter Grade, and click OK. On the Home screen, click Post Grades. Select the class. On the toolbar, click
Refresh.
Skills do not print on the report card. – In the report card setup window, click the Columns tab. Under
Additional, select the Print Skill Grades check box.
The grades are not correct on the report cards. – Recalculate the grades (see page 23). Then, preview the
report cards again.
The overall GPA is not correct on report cards. – In the report card setup window, click the Columns tab. In
the Report List, double-click a grading term, and select Grade. Click Add.
The overall GPA pulls to the report card by the Course Grade, not the last Period Grade . – Some classes
print on the report card that shouldn't, while classes that should print don't. On the Home screen, click
Classes. Double-click the class you want to edit. To include the class on the report card, select the Active
check box.
Attendance and Tardies for school attendance does not print on the report card . – On the Home screen, click
Options. Select Grading Periods. In the Grading Periods window, click Set Dates. Check to make sure
dates are entered for each grading period. Next, calculate grades (see page 23) and attendance (see page
17). Finally, on the Columns tab of the report card setup window, select the Print School Absences YTD
and Print School Tardies YTD check boxes.
The school logo does not appear on the report cards. – You may need to add the school logo to the
HeadMaster data. For more information, see Add Your School Logo to Reports and Report Cards.

4.5 Set up Grading Options
Grading Periods are the sections of time for which grades are given. Usually, grading periods are divided
into weekly increments (often 6 or 9), but can be divided however you like. Administrators can set up as
many as twelve grading periods and name them whatever is most meaningful for your school's record
keeping. You can create as many grading period structures as you need. For example, if your high school
students use different grading periods than your middle school students, you can create a separate grading
period structure for each group.

Warning
Do not change any of the information on grading periods mid-year. This can compromise the
integrity of your data. This information should only be changed at the beginning of a new school
year when no grades have yet been entered. You can, however, add a new grading period, as long
as you do not change a grading period once you have attached grades to it.

Before you set up your grading period structure, it's best to determine a few things about your grading
periods:
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How many grading periods do you have and what are they called? Determine how many grading
periods you need to set up, including semesters, finals, and midterms. For example, HeadMaster Academy
works on 6 six-week grading periods with midterms and finals divided into two semesters. Therefore, they
set up 10 grading periods and name them.
Are the grading periods included in the average? Determine which grading periods count toward a
student’s final average and how much each period counts. Only the selected grading periods are included in
the calculation of the students’ averages.
How much does each grading period weigh toward the final grade? Determine the value of each
grading period. Every period that you want counted toward the average (marked with a check) must have a
weight, and the periods together must equal 100%. Each average must be selected in order to post grades
for that period. If you don't want the posted grades to be averaged, select to add a grade, clear the Average
check box, and click Refresh to update the page. For example, Headmaster Academy's 1st, 2nd, 3rd 6
Weeks, and Midterm weigh equally toward Semester 1. Since there are four periods that weigh equally, they
are each worth 25% of the Semester 1 grading period. The same follows for the 4th, 5th, 6th 6 Weeks and
Finals. They each are worth 25% of Semester 2. Semesters 1 and 2 are each worth 50% of the year since
they make up equal halves.
Does a grading period work with another to form a “grouped grade”, such as a semester grade?
Finally, determine which individual grading periods should be grouped together, for example, to form a
semester or a quarter. Continuing with the HeadMaster Academy example, Semester 1 is a "Grouped
Grade" containing the 1st, 2nd, 3rd 6 Weeks, and Mid-term Exam. Also, Semester 2 is a "Grouped Grade"
containing the 4th, 5th, 6th 6 Weeks, and Final Exams. You must designate the Group With grading periods.

Useful Information
There is a default grading period already set up in HeadMaster. You may edit this or create a new
grading period. If you have multiple grading periods, you can select one to be the default. With the
grading period open, click the Set as Default option beside the name.

4.5.1 Add a New Grading Period
You can create more than one grading period to be used at your school. One grading period should be
selected to be the default grading period used when setting up classes.
To add a new grading period
1. On the Home screen, click Options.
2. Click Grading Periods. The Grading Periods dialog box displays.
3. Click Create New. The Set Period Dates dialog box displays.
4. Enter a name for the grading period. For example, enter “Elementary Grading Period”.
5. Enter the Grading Period Structure information, and click Next. The Set Period Dates dialog box
displays.
6. Enter the start and end dates, and click Close.
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7. By default, the Average check boxes are selected. This means that the grades from each period will
be included in the calculation of course grades. If you don't want to include the grades, clear the
Average check box for the periods you don't want to include.
8. Enter the weight for each period. Weight determines what percentage of the final grade is represented
by this period. The periods must total 100%.
9. In the Group With column, for each period contained within a period (such as each nine-week period
contained in a semester), click the drop-down list to change how the periods are grouped within the
semester. For semesters, the Group With should be set to <none>. The Hierarchy pane displays the
grouping of periods under semesters.
10. To enter a new grading period, click Create New and repeat steps 4-9. When finished setting up
grading periods, click Close.

Tip
Click the Auto Calculate button to distribute weights evenly. Each grading period that's part of a
Group With grade should equal 100%.

4.5.2 Add a Grading Period After the School Year Begins
You can add a new grading period after the school year begins. However, the new grading period won't
automatically display as an option in the Post Grades window. In order to display the new grading period,
you must update the grading periods using the Mass Change feature.
For example, in October, Mr. Jones decided that he wanted to add midterm exams to his High School
Grading Period. However, teachers had already begun to post grades in the database. Mr. Jones edited the
high school grading period, but he couldn't see the addition of midterm exams when he viewed the Post
Grades window. Mr. Jones must update the grading periods for all high school classes using the Mass
Change feature before grades can be posted to midterm exams.
To update grading periods
1. On the File menu, click Mass Change.
2. In the Available Fields list, expand Setup and select Grading Period.
3. In the Grading Period drop-down list, select the grading period you want to update.
4. Select the check boxes for the periods you want to update.
5. To update all classes, click Select All and go to step 8.
6. To update specific classes, click Select.
7. Select the classes you want, click Add, and click OK.
8. Click Update.
9. To confirm, click Yes.
10. Click OK.
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4.5.3 Set Dates for Grading Periods
After you set up each grading period, set the calendar dates for the school year.
To set dates for grading periods
1. On the Home screen, click Options.
2. Click Grading Periods. The Grading Periods window displays.
3. If you have more than one grading period, click the grading period tab (located at the bottom of the
window) that you want to set up dates for.
4. Click Set Dates.
5. In the Set Period Dates dialog box, enter the start and end date for each period.
6. Click Close.

4.5.4 Edit a Grading Period
Warning
Do not change any of the information on grading periods mid-year. This can compromise the
integrity of your data. This information should only be changed at the beginning of a new school
year when no grades have yet been entered. You can, however, add a new grading period, as long
as you do not change a grading period once you have attached grades to it.

To edit an existing grading period
1. On the Home screen, click Options.
2. Click Grading Periods. The Grading Periods window displays.
3. Change the grading period information.
4. When finished editing the grading period, click Close.

4.5.5 Prevent Post Reporting Period Grade Changes
(Administrator Only)
At the end of a grading period, you can lock the grade book. This prevents teachers from making last minute
changes to entered grades and encourages students to make up any missed work in a timely manner. Once
a grading period is locked, a teacher cannot add, edit, or delete an assignment or change grades in that
grading period.
To lock a grading period
1. On the Home screen, click Options.
2. Click Grading Periods. The Grading Periods window displays.
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3. Select the grading period tab (located at the bottom of the window) for the grading period you want to
lock.
4. Beside the semester or nine-weeks you want to lock, select the Locked check box. A confirmation
dialog box displays.
5. Once you have locked all grading periods you want to change, click Close.

Note
Once grading periods have been locked, they continue to display on the Grading Periods window,
but are highlighted in yellow.

4.5.6 Set Up Grading Scales
A grading scale contains grades that are a symbolic representation of a student's performance in a class or
curriculum. In HeadMaster, each grading scale can consist of a numeric system with up to two letter grade
equivalents and a corresponding grade point scale. You must enter a numeric grade in the gradebook to
calculate student averages. Also, if you track grade point averages, you must enter a grade points scale.
The grading scale can print on report cards so that parents and students know what grades mean for each
reporting period.
The table below contains one example of a grading scale.
Numeric (Greater Than) Letter Grade 1 Letter Grade 2 Grade Points
0

F

U

0

60

D-

U

1

63

D

U

1

67

D+

U

1

70

C-

S

2

73

C

S

2

77

C+

S

2

80

B-

S

3

83

B

S

3

87

B+

E

3

90

A-

E

4

93

A

E

4

97

A+

E

4
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Add a New Grading Scale
You can add an unlimited number of grading scales.
To add a grading scale
1. On the Home screen, click Options.
2. Click Grading Scale. The Grading Scales window displays.
3. Click Create New. The New Grading Scale dialog box displays.
4. Enter a name for the new grading scale, and click OK.

Useful Information
After you add a grading scale, you can select one scale to be the default. With the grading
scale open, click the Set as Default check box beside the name.

5. Click Add. The Grading Scale dialog box displays. Enter the following grade information for each level
of your grading scale:
Numeric (Greater Than or Equal To) - Enter the lowest possible number of the grade. For
example, if the letter grade is F, the lowest possible numeric grade is 0 (zero).
Letter Grade 1 - Enter the letter grade equivalent of the numeric grade. This letter grade is
usually reserved for the typical A, B, C, D, F grading scale.
Letter Grade 2 - Enter a second letter grade equivalent for the numeric grade. This letter
grade is usually reserved for the typical E, S, U grading scale.
Grade Points - Enter the number of points the grade level is worth. Usually, this scale is one to
four or one to five. The grade points are used to calculate the GPA or Grade Point Average.
6. Set up any of the Grading Options you want to use.
7. Click Close.

Note
If you delete all of the levels for a grading scale, the entire grading scale will be deleted.

Grading options affect how grades are weighted and ultimately calculated. Use the following fields to help
you weight classes:
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Additional Field Information
Extra grade points for honors
Enter the number of extra points in the field.
Extra grade points for AP
Enter the number of extra points in the field.
Use credits to weigh subjects GPA
Include credits in the calculation of the student's GPA. With this option, some classes could have more
weight than others.
Use Credits to weigh subjects Average
Use the credits assigned to the class to weigh the subject in the calculation of the student's overall
average. If this option is not selected, then all classes have the same weight.
Failing Grade
Enter a numerical grade that indicates the student is failing. This grade, and all grades below, will
display in red in the gradebook.
Round Average to
Select the number of decimal places to round averages to, from 0 to 4. If you select 0, the average will
be rounded to the nearest whole number.
Round GPA to
Select the number of decimal places to round the GPA to, from 0 to 4. If you select 0, the GPA will be
rounded to the nearest whole number.

Note
If you set different rounding decimal places for different grading periods and a student has
classes in both, their overall average will use the highest decimal place selected. This applies
to both Round Average To and Round GPA To.

Change a Grading Scale
You can edit information in your grading scale.

Useful Information
If you change your grading scale in the middle of a term, the grades recalculate throughout the
system.

To change a grading scale
1. On the Home screen, click Options.
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2. Click Grading Scale. The Grading Scales window displays.
3. Select a grading scale, and click Edit.
4. Edit the information, and click Close.

Learn How HeadMaster Calculates the GPA
Student Grade Point Averages (GPAs) can be calculated in one of two ways:
If you don't select Use credits to weight subjects GPA when you set up your grading scale, GPAs will be
calculated using the “Number of Classes” method, as follows:
Total GPA Points/Number of Classes Taken = Grading Period GPA
If you select Use credits to weigh subjects GPA when you set up your grading scale, GPAs will be
calculated using the “Credits Taken” method, as follows:
Credits Taken x GPA Points = Class GPA
Total of all Class GPAs/Credits Taken = Grading Period GPA
Credits Taken GPA Points Class GPA
Class A

1

4.00

Class B

1

4.00

Class C

1

3.70

Class D

1

3.70

Class E

.5

4.00

Class F

1

3.70

6 Classes 5.5

23.1

2.00

21.1

Number of Classes Method:
23.1 (Total GPA Points)/ 6 (Number of Classes Taken) = 3.85 (Grading Period GPA)
Credits Taken Method:
21.1 (Total of all Class GPAs)/ 5.5 (Credits Taken) = 3.84 (Grading Period GPA)

Useful Information
For any students auditing a class, a red rectangle appears to the right of their names. If any grades
are entered for these students, they aren't included in the overall average or GPA for them. For
more information, see Marking Students Who Are Auditing a Class.
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4.5.7 Enter Grading Information for Subjects and Classes
As an administrator, when you set up subjects in Headmaster, you can select the grade type that you want
to appear on the report card (numeric, letter, or points), options that affect the overall grade (such as adding
a point for Honors or AP classes), and the method by which the final grade should be calculated (by
averaging assignments or by averaging periods).
For example, HeadMaster Academy’s grading scale indicates that students receive an extra grade point for
Honors classes, and a half grade point for AP classes. Additionally, the school has a policy that final grades
should be calculated by averaging assignments. All classes should be included in the GPA and on the
transcript. The school also wants to print the numerical and letter grade 1 on student report cards.
Mrs. Smith, an administrator for HeadMaster Academy, sets up classes for the school. First, she enters
subjects, such as English, Biology, and History. In the Edit Subject window for each subject, Mrs. Smith
selects the following options:
For Grade Type, Numerical/Letter Grade 1
Include in GPA
Include in Transcript
Calculate final grade by averaging assignments
When setting up subjects, Mrs. Smith does not select the Honors or AP option because only one of the
multiple classes for each subject will be Honors or AP. She can set those options on the individual class
record.

Next, Mrs. Smith sets up six English classes for ninth grade, four for the tenth grade, five for the eleventh
grade, and five for the twelfth grade. In the Classes window, she clicks the Subjects tab. The settings she
entered for the English subject have been applied. For the single Honors and AP class for each grade, she
selects the Honors or AP options, as appropriate.
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4.6 Access the Post Grades Assistant
Users of HeadMaster Pro can post grades using the Post Grades Assistant, also called the "gradebook."

Tip
You can navigate through the gradebook with the arrow keys.

To access the Post Grades Assistant, on the Home screen, click Post Grades.
You can also access the gradebook from the Classes window. On the Home screen, click Classes. In the
Class List window, select the class you want to post grades for. On the toolbar, click Grades.
Prior to posting grades, make sure the following items have been completed.
The administrator set up grading periods.
The administrator set up grading scales.
(Recommended) The administrator entered grading information for subjects and/or classes.
The teacher set up assignment types and entered assignments.
The Post Grades Assistant displays the gradebook. For each student, the gradebook displays attendance,
grades for assignments, report card notes, and grade averages. If you don't have HeadMaster Pro, your
Post Grades Assistant window doesn't display the “Calculated Average” column. Instead, you will see a
column labeled “Average”. Additionally, the Adjusted Average only appears under the grading period for
which the system is calculating the grades.
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5 Manage Student Behavior Records
What do you want to do?
Associate Unit Numbers With Actions Taken (see page 46)
Delete Student Behaviors (see page 47)
Enter Behavior Information (see page 48)
Set Up Behavior Lists (see page 50)
Work with Grids

5.1 Associate Unit Numbers With Actions Taken
With some prior planning, you can associate unit numbers with pre-defined actions taken in the Define Lists
window. Then, when you select an action taken in the student’s behavior record, the number of units
previously associated with that action automatically fills the record.
You can still change the unit number in the Behavior window if you need to.

To associate unit numbers with Actions Taken
1. On the Home Screen, click Define List.
2. Under Available Fields, expand the Behavior category and click Action Taken.
3. In the list of available actions, select an action and click Edit. The Behavior Action Taken dialog box
displays.
4. In the Units field, enter a number (negative or positive) and click OK.
5. Repeat steps 3 and 4 for each action.
6. When finished associating units with actions, in the Define List window, click OK to close.
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Sometimes a student receives demerits but performs work to reduce them. In cases like this, you can enter a
negative number of units to reduce the demerit totals. The Behavior Summary report will display and
subtract the negative demerits from the overall total.

5.2 Delete Student Behaviors
There are two ways to delete behavior records, depending on the reason the record is being removed. For
example, in the event that a record was entered in error, or you want to remove a behavior incident for some
other reason, you can delete a single behavior record.
However, because student behaviors remain in the dataset from year to year, you might also find it
necessary to delete behaviors for all students or for specific groups of students at the end of the school year
or prior to the beginning of a new school year. To do this, you will need to use the Mass Change feature.
To delete a single behavior record
1. On the Home screen, click Behavior.
2. Select the behavior you want to delete.
3. On the toolbar, click Delete.
4. When the confirmation message displays, click Yes.
To mass delete behaviors for all students
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1. On the File menu, click Mass Change.
2. Double-click Students.
3. Click Behaviors.
4. Select one of the following:
To remove behavior records that occurred on any date, select All Dates.
To specify behavior records within a specific time period, such as the first semester, select
Date Range and enter beginning and ending dates.
5. Click Select All.
6. Click Delete.
7. To confirm, click Yes.
8. Click OK.
To mass delete behaviors for selected students
1. On the File menu, click Mass Change.
2. Double-click Students.
3. Click Behaviors.
4. Select one of the following:
To remove behavior records that occurred on any date, select All Dates.
To specify behavior records within a specific time period, such as the first semester, select
Date Range and enter beginning and ending dates.
5. Click Select.
6. Click Delete.
7. Select the students you want to remove behaviors for.
8. Review the list and remove students for whom you don't want to remove behaviors. Click OK.

Student names that are removed from the list will retain their behaviors.

9. Click Delete.
10. To confirm, click Yes.
11. Click OK.

5.3 Enter Behavior Information
Behavior information is generally entered in the behavior window. However, you can also enter behavior
records from the student list window. For more information, see Access Student Behavior Records.
To enter behavior information
1. On the Home screen, click Behavior.
2. On the toolbar, click New.
3. Enter behavior details.
4. To save the record, click OK.
To change or update a behavior record
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1. On the Home screen, click Behavior.
2. In the Behaviors window, double-click the behavior note you want to edit.
3. Make the changes.
4. To save the record, click OK.

Additional Field Information
Student
Select the name of the student you are entering the behavior record for.
Behavior Code
Behavior codes are generally brief descriptions or categories of behavior issues, and they are set up in
Options. Examples of behavior codes include: Fighting, Truancy, or Good Behavior.
Behavior
Enter an explanation of the behavior incident. For example, “Brison yelled at the teacher after being
asked to take her seat.”
Reported By
The teacher who reported the student's behavior.
Date
The date defaults to “today’s date.”
Assigned To
Select an individual who has the duty to make sure the school responds to the student's behavior if
necessary. For example, principal, vice principal, teacher, or coach are examples of individuals who can
follow up on a student's discipline.
Action Taken
Click the Action Taken drop-down list and select a description of the action. Or, select New from the
Action Taken list and enter a new action taken. The action date is the date that the school's response to
the behavior should take place.
Action Date
The date that the school's response to the behavior took place.
Unit Type
Select a Unit Type (demerits, merits) from the Unit Type list or select New and enter a new unit type.
Units
The number of units (demerits, merits, hours) assigned to the behavior. For example, if the student
receives demerits for fighting, select Demerits from the unit type list and type 5 in the units field.
Completed
This true/false field is used to record whether the school's response to the behavior was completed.
Notes
You can use the Notes field to further document disciplinary activity such as conversations with parents,
students, or school and law enforcement officials.
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5.4 Set Up Behavior Lists
Before you enter behavior records, you can customize the user-defined behavior lists. Then, when you enter
behaviors, you can select the Action Taken, Behavior Code, and Unit Type from the customized lists you
created.
An Action Taken is a brief description of the type of discipline or follow-up to a discipline issue that will be
taken. Examples include: Referred to principal, Suspended, Write sentences, or Expelled.
To customize the Action Taken list
1. On the Home screen, click Define Lists.
2. In the Available Fields list, expand Behavior.
3. Click Action Taken.
4. Click Add. The Behavior Action Taken dialog box displays.
5. Enter a description, and click OK.
6. Repeat steps 3 through 5 for each action taken you want to add.
7. Click OK.
Behavior Codes are generally one-or-two word descriptions that generally describe a type of behavior.
Examples include: Fighting, Disruptive, or Truancy.
To customize the Behavior Code list
1. On the Home screen, click Define Lists.
2. In the Available Fields list, expand Behavior.
3. Click Behavior Code.
4. Click Add. The New Behavior Code dialog box displays.
5. Enter an behavior code, and click OK.
6. Repeat steps 3 through 5 for each behavior code you want to add.
7. Click OK.
Unit Type is the category or value that will be awarded the student for behavior. Examples include: Demerits
or Days. When entering behavior records, you can assign a numerical value to the unit type, such as 3
demerits or 4 days of suspension.
To customize the Unit Type list
1. On the Home screen, click Define Lists.
2. In the Available Fields list, expand Behavior.
3. Click Unit Type.
4. Click Add. The New Behavior Unit Type dialog box displays.
5. Enter a unit type, and click OK.
6. Repeat steps 3 through 5 for each unit type you want to add.
7. Click OK.
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6 Manage Permanent Records
What do you want to do?
Add an Activity to a Student's Permanent Record (see page 51)
Calculate Class Ranks (see page 51)
Record Standardized Tests (see page 52)
Update Permanent Records (see page 55)
Update Transcripts (see page 59)
Work with Grids

6.1 Add an Activity to a Student’s Permanent Record
A permanent record contains the complete school history for a student. Permanent records include personal
information, transcript details, and standardized test scores that can be modified and added to from term to
term.
Individual class information can also be tracked in permanent records. Within a school term, you can include
information on the individual classes the student has taken or transferred during the term, as well as grades
and credits received.
When you update permanent records, any activities in a student’s record are added to his or her permanent
record; however, you can add an activity directly to the permanent record.
To add an activity
1. On the Home screen, click Permanent Records.
2. Double-click the student you want to view.
3. Click the Activities tab.
4. Click Add. The Enter Activity Information dialog box displays.
5. In the Term Name drop-down list, select the school term in which the activity took place.
6. In the Description field, enter the activity. For example, band or soccer.
7. In the Start Date and End Date fields, enter the dates the student was involved in the activity.
8. Click OK.

6.2 Calculate Class Ranks
You can perform a class rank calculation for any term and grade level within the Permanent Records
section.
To calculate class rank
1. On the Home screen, click Permanent Records.
2. On the toolbar, click Set Class Rank. The Class Rank Assistant displays.
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3. Select a term, grade level, and evaluation method, and click Next.

Useful Information
The first evaluation method in the list is the primary ranking method.

4. Exclude any students you want, and click Post.

6.3 Record Standardized Tests
What do you want to do?
Add a New Standardized Test (see page 52)
Add Standardized Test Scores (see page 53)
Delete a Standardized Test (see page 53)
Delete Standardized Test Information (see page 53)
Edit a Standardized Test (see page 54)
Edit Standardized Test Information (see page 54)
Enter Standardized Test Scores for Students (see page 54)
Print Standardized Test Information (see page 55)

6.3.1 Add a New Standardized Test
A standardized test is one that is administered under controlled conditions that specify where, when, how,
and for how long children may respond to questions or prompts. These tests can include:
State Mandated Tests - tests required by your state for graduation from high school.
College Entrance Tests - tests required for admission to most colleges and universities. The most
common college entrance tests are the SAT and the ACT.
IQ Tests - tests that measure the test taker's intelligence quotient.

Useful Information
Students must have a Permanent Record before you can record test scores for them. If you have
not already done so, run Update Permanent Records to add student records. For more information,
see Update Permanent Records (see page 55). In addition, you must set up standardized tests in
HeadMaster. Test scores can be printed in a list or on transcripts.

To add standardized tests
1. On the Home screen, click Standardized Tests. The Set Up Standardized Tests dialog box displays.
2. Click Add. The Set Up Fields dialog box displays.
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3. Enter the test name. If you don't want the test to print on students’ transcripts, clear the Print on
transcript check box.
4. Click Add. The Field Name dialog box displays.
5. Enter the standardized test field. For example, if you are adding the SAT, you would add three fields:
Critical Reading, Mathematics, and Writing.
6. Click OK. Repeat steps 5 - 6 for each field you want to add.
7. Click OK > Close.

6.3.2 Add Standardized Test Scores
Once the standardized tests are added, you can add the test scores.
To add standardized test scores
1. On the Home screen, click Standardized Test Scores. The Standardized Test Scores dialog box
displays.
2. In the Test Name drop-down list, select a test.
3. Click Add. The Test Scores dialog box displays.
4. Enter a score, and click OK.

6.3.3 Delete a Standardized Test
You can delete a standardized test as long as no test scores have been entered for the test.
To delete a standardized test
1. On the Home screen, click Standardized Tests. The Set Up Standardized Tests dialog box displays.
2. Select the test you want to remove, and click Delete.
3. Click Close.

6.3.4 Delete Standardized Test Information
You can delete standardized test information if there are scores entered. When you select to delete scores,
a message displays, noting that all associated student scores will be removed as well.
To delete standardized test scores
1. On the Home screen, click Permanent Records.
2. Double-click the student you want to view.
3. Click the Standardized Tests tab.
4. Select a test, and click Delete.
5. Click Yes to confirm.
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6.3.5 Edit a Standardized Test
If you made a mistake when entering a standardized test, or if you need to add additional fields to the test,
you can edit the test as well as the test fields.
To edit a standardized test
1. On the Home screen, click Standardized Tests. The Set Up Standardized Tests dialog box displays.
2. Select the test you want to edit, and click Edit. The Set Up Fields dialog box displays.
3. Change the test name, or to change a field, select it and click Edit.
4. Click OK > Close.

6.3.6 Edit Standardized Test Information
You can change standardized test information for a student.
To edit standardized test scores
1. On the Home screen, click Permanent Records.
2. Double-click the student you want to view.
3. Click the Standardized Tests tab.
4. Select a test, and click Edit. The Test Scores dialog box displays.
5. Edit the test information, and click OK.

6.3.7 Enter Standardized Test Scores for Students
You must set up standardized tests before you can enter standardized test information on the student’s
transcript.
There are two ways to enter standardized test scores:
If you have many test scores to enter, you can enter them in the Standardized Test Scores section
which allows you to search for student names or filter by grade level, and enter the scores in a grid.
When you only have one or two scores to enter, you can enter them in the Permanent Records
section.

Note
Only students with permanent records display in the list.

To enter standardized test scores
1. On the Home screen, click Standardized Test Scores. The Standardized Test Scores dialog box
displays.
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2. In the Test Name drop-down list, select the name of the standardized test for which you are posting
scores. The Default Test Date displays. You can change this date.
3. To filter students by grade, click the Grade Level drop-down list, and select a grade level.
4. Under Student Name, select a student.
5. Click Add. The Test Scores dialog box displays.
6. In the Test Scores dialog box, enter the test scores and click OK.
7. Select the next student and repeat steps 4 - 6 for each student.
8. Click Close.
To enter standardized test scores via Permanent Records
1. On the Home screen, click Permanent Records.
2. Double-click the student record you want to view.
3. Click the Standardized Tests tab.
4. Click the Test Name drop-down list, and select a test.
5. Click Add. The Test Scores dialog box displays.
6. Enter the test date.
7. Click in the field beside the test field, and enter the test scores for each field.
8. Click OK.

6.3.8 Print Standardized Test Information
You can print standardized test information for a student from the student’s permanent records. You can also
print student test score information from the Permanent Record reports.
To print a student’s standardized test information
1. On the Home screen, click Permanent Records.
2. Double-click the student you want to view.
3. Click the Standardized Tests tab.
4. Click Print.

6.4 Update Permanent Records
What do you want to do?
Add a Single Permanent Record (see page 56)
Define Diploma Types and Programs of Study (see page 56)
Delete a Permanent Record (see page 57)
Determine How Grades Should be Calculated on the Transcript (see page 57)
Edit a Student’s Permanent Record (see page 59)
Update a Permanent Record (see page 59)
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6.4.1 Add a Single Permanent Record
Permanent Records consist of three types of records: personal information, transcript information, and
standardized test scores. To access permanent records, on the Home screen, click Permanent Records.
If a permanent record doesn't already exist for a student, you must add a record prior to entering transcript
information or standardized test scores.
To add a permanent record for all students in your data, use the Update Permanent Records assistant to
create records and calculate grade averages. For more information, see Update Permanent Records (see
page 55).

Note
A student must be an active student in the dataset you are working in before permanent records
can be added.

To add a single permanent record
1. On the Home screen, click Permanent Records.
2. On the toolbar, click New. The Select Student dialog box displays.
3. In the Select Student dialog box, double-click a student’s name.
4. When the confirmation message displays, click Yes. The student’s personal information, (name, DOB,
SSN, gender, and contact information automatically fill the fields on the Personal tab). You can edit
this information.
5. To enter transcript details and summary information, click the Transcript tab. For more information,
see Update Transcripts (see page 59).
6. To enter or view standardized test scores, click the Standardized Tests tab. For more information,
see Record Standardized Tests (see page 52).
7. To save the record, click OK.

6.4.2 Define Diploma Types and Programs of Study
A student’s permanent record contains information for transcript purposes, such as Diploma Type and
Program of Study. These fields categorize a student’s school career focus. For example, some Diploma
Types could be “Bachelors” or “Tech Center.” Program of Study can also be referred to as a track. A track is
a student’s class focus such as “College Preparatory,” “Business,” or “Technology.”
To add Diploma Types or Programs of Study
1. On the Home screen, click Define List.
2. In the Available Fields list, expand Transcripts and select Diploma Type or Program of Study.
3. Click Add. A dialog box displays.
4. In the Code field, enter a code for quick reference.
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5. Enter a description.
6. Click OK.

6.4.3 Delete a Permanent Record
We recommend that you print a copy of a student’s permanent record prior to deleting it.

Note

If you delete a student who already has a permanent record and later add the student back
to the dataset, a duplicate permanent record will be created.
Deleted permanent records cannot be recovered.

To delete a permanent record
1. On the Home screen, click Permanent Records.
2. Select a student, and click Delete.
3. To confirm, click Yes.

6.4.4 Determine How Grades Should be Calculated on the
Transcript
HeadMaster normally calculates grades (weighted or unweighted) on the transcript using the Average Terms
method. If selected, HeadMaster adds each term’s overall grade average and divides by the number of
terms. If you want transcripts calculated using this method, because this is the default method used by
HeadMaster, you don't need to make any changes to the permanent record options.
If permanent records are converted or transfer classes are brought in with blank averages, but they've been
assigned a letter grade and/or a GPA, you can now fill in the averages using the Fill Blank Averages mass
changes option. See Fill Blank Grade Averages to learn more.
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Alternatively, you can select to calculate grades using the Average Classes method. HeadMaster adds the
class grades taken for each term and divides by the number of grades to obtain the overall average or GPA
(unweighted). If you want transcripts calculated using this method, you must change Permanent Record
Options.

To average transcripts by classes
1. On the Home Screen, click Options.
2. Click Permanent Records.
3. Select Average Classes, and click Close. You can now update permanent records.
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6.4.5 Edit a Student’s Permanent Record
Before you update permanent records, determine and set up how you want grades to be calculated on the
transcript. For more information, see Determine How Grades Should be Calculated on the Transcript (see
page 57).
To print a list that contains information from several students’ records, customize the grid view and then print
it. See Work with Grids.
If you use multiple datasets, be aware that after you update permanent records, all permanent records can
be viewed or printed from and across any dataset. For example, if Mr. Jones updates permanent records for
his dataset that contains the lower school students, these records can be viewed or printed in his dataset
containing upper school student records.
To edit a permanent record
1. On the Home screen, click Permanent Records.
2. Double-click the student’s name.
3. To save changes you made to the permanent record information, click OK.

6.4.6 Update a Permanent Record
To keep permanent records current, use the Permanent Record Assistant to update student records.
This process creates a permanent record for each student and updates grade averages. Grade averages
must be calculated by Calculate Course Grades before the update Permanent Record Assistant can be run.
To update permanent records
1. On the Home screen, click Update Permanent Records. The Update Permanent Records dialog box
displays.
2. Select to update the entire database, a single student, a group of students, or an entire grade level. If
you select Update a single student or a group of students, click Select Students to choose the
records you want to update. If you select Update a range of grade levels, select a grade level from the
drop-down list.
3. Select the start and end dates for the current school term.
4. Click Next.
5. Select one or more Grading Periods.
6. Click Next.
7. When the calculations are complete, click OK.

6.5 Update Transcripts
What do you want to do?
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Add Semester or Quarter Grades, GPAs, and Credits (see page 60)
Edit Transcript Information (see page 60)
Enter Transcript Information for a Transferring Students (Term Summary) (see page 62)
Export Transcripts for XAP (see page 63)
Print Transcripts (see page 65)
Get Answers to Common Questions About Transcripts (see page 65)

6.5.1 Add Semester or Quarter Grades, GPAs, and Credits
If your grading periods are composed of semesters or quarters, when you run Update Permanent Records,
the semester or quarterly grades will automatically be added to the Semester/Quarter Grade dialog box.
However, if you need to add historical information, for example, when a student transfers, you can do that on
the Permanent Record Subjects tab. Add grades for each semester or quarter, letter grades, GPAs, and
earned credits.
The Student Transcript Detail report will print semester/quarterly averages, while the Transcripts by
Semester report will print both averages and credits.
To add a semester or quarter grade average
1. On the Home screen, click Permanent Records.
2. Double-click a student's name.
3. Click the Transcript tab.
4. Select a term from the Transcript Detail grid, and click Edit. The Permanent Record Term dialog box
displays.
5. Select a class from the Term Subjects grid, and click Edit. The Permanent Record Subject dialog box
displays.
6. On the Permanent Record Subject window, click Add. The Semester/Quarter dialog box displays.
7. To select the semester or quarter for which you are adding an overall grade, click the
Semester/Quarter drop-down list.
8. Enter the grade average for the student. You can use numeric and letter grades.
9. If needed, add GPA and earned credit data. Denote incomplete terms, too, if applicable.
10. If applicable, enter a GPA No Honors value. This field is only visible if your school uses the AP/Honor
Points feature set up in the Options > Permanent Records window.
11. Click OK.

6.5.2 Edit Transcript Information
Transcripts are the cumulative record of a student's school career. The transcript follows a student
throughout their education and is used for gaining admittance to a college or university.
Several different types of information are included on student transcripts including graduation date, class
rank, cumulative credits, cumulative GPA, and cumulative grade average. Also included are the details of the
student's schooling, such as the classes taken during school terms and transfer information.
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Information contained on the Transcript tab includes courses and grades that a student has taken at your
school as well as courses and grades transferred from other schools. The tab is divided into two sections.
The Transcript Summary area displays grade average and credit information for the current term. Previously
calculated averages and credits are automatically updated when you run the Update Permanent Records
Assistant (See Update Permanent Records (see page 55).). The Term Subjects area lists detailed
information for each subject that the student completes.

Note
Your school might calculate weighted averages. Here, briefly, is how weighting works:
Weighted calculation takes into account the Credits Earned and Credits Taken fields, while
unweighted calculation uses the number of classes taken instead. Weighting is not the same
as calculating averages based on AP or honors classes, described below.
If you are using the AP/Honors feature found in the Options > Permanent Records window,
the field GPA No Honors is included in the Weighted and Unweighted boxes on the
Transcript tab. The calculation made is exactly the same as that for weighted and
unweighted, but does not assign additional points for AP or honors classes.

You can edit transcript information for a student's record as long as nothing has been entered in the
Transcript Detail grid. Edit grade and credit transcript information throughout the student’s record by
updating it on the Subject detail tab.
To edit transcript information
1. On the Home screen, click Permanent Records.
2. Double-click a student name..
3. Click the Transcript tab.
4. Edit the information, and click OK..
The following fields are included in the Term Summary and are automatically calculated when you run the
Update Permanent Records Assistant or when you enter Permanent Record Subjects.
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Additional Field Information
Graduation Date
The student's expected graduation date. For example, 05/30/2015.
Class Rank
The student’s relative position or standing within the class.
Active Term
The name of the active school term. For example, 2014 - 2015.
Overall Credits Earned
The cumulative number of credits a student has earned.
Overall Credits Taken
The cumulative number of credits a student has taken.
Overall GPA
The cumulative grade point average for the student.
Overall Average
The overall grade average for the student. For example:100.
Diploma Type
The type of diploma the student was working toward: business, technology, vocational, nursing, etc. For
schools required to send transcripts electronically, this field might be required in the data export, but
isn't required by HeadMaster.
Program of Study
The area of study the student was involved in. For schools required to send transcripts electronically,
this field might be required in the data export, but isn't required by HeadMaster.
Administrative Hold
Indicate a hold on the transcript for this student due to unpaid fees, etc. The hold flag will be noted
during the Update Permanent Records process.

6.5.3 Enter Transcript Information for a Transferring Students
(Term Summary)
Each school term contains detailed information about the subjects that the student has taken. When you
click the Transcript tab, the current term is summarized. Details for each school term are further summarized
under Subject Detail. To view subject details, double-click a term name.
If the student transfers credits for subjects from another school, you can manually enter permanent record
history for the student. You don't need to enter this information if the student is already in the HeadMaster
system. It's automatically entered in the student's permanent record.
To enter transcript information for a transferring student
1. On the Home screen, click Permanent Records.
2. Double-click a student name.
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3. Click the Transcript tab.
4. In the Transcript Detail grid, click Add. The Permanent Record Term dialog box displays.
5. Beside Term Subjects, click Add. The Permanent Record Subject window displays.
6. Enter the class name and course number.
7. Select a subject from the Subject drop-down list; or, if the student transferred in and took a subject
not offered at your school, enter the name of the subject. Subjects entered in this field will be saved to
the student record.
8. Enter the name of the teacher who taught the subject.
9. Enter the number of credits earned by the student for the subject.
10. Enter the number of credits taken.
11. Select one or more of the following options as they apply:
If this subject was transferred from another school, select the Transferred check box.
To calculate the subject as part of the grade point average, select Include in GPA.
To include this subject in the transcript calculations, select Calculate on Transcript.
To print this subject on the transcript, select Print on Transcript.
12. Click the Department list and select a department name, or enter the name of a department.
13. In GPA, enter the grade points earned for the subject.
14. In Average, enter the current grade average for this subject, then enter the equivalent Letter Grade.
15. Optional: Enter Semester/Quarter Grades. For more information, see Add Semester/Quarter
Grades, GPAs, and Credits (see page 60).
16. Click OK.

6.5.4 Export Transcripts for XAP
With HeadMaster, you can export student transcripts in a format compatible for uploading into XAP™
Corporation's Transcript Exchange program.
Before you can export to XAP, make sure you complete the following required fields in each student’s
permanent record.

Useful Information
Many of these fields automatically populate when you run Update Permanent Records.

On the Personal tab:
Last Name
First Name
Middle Name
Date of Birth
SSN
Address Line 1
City
State
ZIP Code

Page 63 of 66

HeadMaster
Phone Number
On the Transcript tab:
Graduation Date
Current Grade Level
Diploma Type
Program of Study
On the Transcript tab, under Transcript Detail, edit each term to include:
Grade Level
Term Year - Start Date
Term Year - End Date
Program of Study
In the Permanent Record Term window, under Term Subjects, edit each subject to include:
Class
Course Number
Credits Earned
Credits Taken
Average
To export transcripts for XAP
1. On the Microsoft® Windows® toolbar, click Start.
2. Click All Programs > HeadMaster > XAP Export.
3. Select either Preliminary or Final Export.

Useful Information
If you select Preliminary, the following information is optional: graduation date and diploma
type. Blank grades, blank term dates, and blank credits are also allowed with the Preliminary
option.

4. Verify that your school’s information is entered correctly.
5. Under Select which students to export, click Select.
6. Select the student records you want to export, and click Add.
7. Click Close.
8. Under Save file to following location, click Lookup.
9. Navigate to the location you want to save the export file, and click Save.
10. Click Run.
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Note
When running a Final Export, if any of the required fields haven't been completed, a Listing of
Errors displays. You can save this list for reference. You cannot complete the export until you
correct the errors.

6.5.5 Print Transcripts
When students requests copies of their transcript, first verify their information is up-to-date.
Run the Update Permanent Records Assistant before printing transcripts. For more information, see Update
Permanent Records (see page 55).
To print transcripts
1. On the Home screen, click Reports.
2. In the Report List, expand Grades.
3. Click a transcript report.
4. Select the report options. You can select a term under Available Terms, by clicking Add.
5. To specify a student, click Select, click the student’s name, and click Add.
6. Click the Additional tab, located at the bottom of the window, and make your other selections.
7. On the toolbar, click Print.

6.5.6 Get Answers to Common Questions About Transcripts
The following is a list of frequently asked questions about transcripts:

What must be done before information will display on the transcripts?
You must run Update Permanent Records before information will display on the transcripts.

What do you need to check if a student transcript doesn't display after you run Update Permanent
Records?
Verify the student is active.

What do you need to check if a class doesn't display on the transcripts or in permanent records?
Verify the class is active. On the class record, click the Subjects tab and ensure Ungraded check box is
clear.

How can you display only the term you want on the Transcript?
Select Reports, Grades, Student Transcript, or Student Transcript Detail. Under Available Terms, select
the term you want and move it to Selected Term.
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What do you need to check if you preview the transcript and it displays a blank page?
On the Additional tab, verify if any information is in Graduation Date, Overall Credits Earned, Overall
GPA, or Overall Average. If the graduation date is on the Additional tab but not on the student’s record, no
information will display.

Where should you check after you have run Update Permanent Records, but don't see a student
term?
Select Tools > Options > School Information and see if a Term Description is entered.

When you go into Permanent Records and edit a term, for one class the box isn't selected to display
or calculate on transcripts. What must you do so it'll display without editing each student’s record?
On the Home screen, select Classes. Edit the class, and click the Subjects tab. Select the Include in
Transcript check box. You'll need to refresh the class. To do so, click the Subjects tab then Post Grades.
Then, on the toolbar, click Refresh. Close Post Grades and Classes. On the Home screen, click Calculate
Grades then click Update Permanent Records.

What do you need to do if the Credit Earned displays for the year but needs to display for the
semester?
Select Classes, and then edit the appropriate class. Click the Subjects tab. Under *Earn Credits Based
On*, select Semester/Quarter. Click Post Grades, and then Refresh. On the Home screen, click Calculate
Grades then click Update Permanent Records.

Under Permanent Records on the Transcript tab, where is the Transcript Summary information
gathered from?
The Transcript Summary information is gathered from Transcript Detail Information.

Under Transcript Summary, is the class rank gathered from the system?
Yes.

What displays on the Transcript Summary?
The following displays on the Transcript Summary:
Graduation Date — This pulls from the student record.
Class Rank — This information is required.
Active Term — This pulls form School Information.
Overall Credits Earned — This is calculated from Permanent Records.
Overall Credits Taken — This is calculated from Permanent Records.
Overall GPA — This is calculated from Permanent Records.
Overall Average — This is calculated from Permanent Records.
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